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Important Notice 

This document is delivered subject to the following conditions and restrictions: 

 This guide contains proprietary information belonging to YCD Multimedia Ltd. Such information is supplied solely 

for the purpose of assisting explicitly and properly authorized users of YCD Multimedia Products. 

 No part of the contents may be used for any other purpose, disclosed to any person or firm, translated or 

reproduced by any means, electronic and mechanical, without the express prior written permission of 

YCD Multimedia Ltd. 

 The text and graphics are for the purpose of illustration and reference only, based on the current version of the 

product(s) described in this document. 

 The software described in this document is furnished under a license agreement. The software may be used or 

copied only in accordance with the terms of that agreement. 

 Information in this document is subject to change without notice. Corporate and individual names and data used 

in examples herein are fictitious unless otherwise noted. 

 YCD Multimedia Ltd. makes no warranty of any kind with regard to this printed material, including, but not limited 

to, the implied warranties of merchantability and fitness for a particular purpose. YCD Multimedia Ltd. shall not be 

liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, 

performance, or use of this material. 

 Brand or product names are trademarks of their respective companies or organizations. 

 

Copyright © 2019 YCD Multimedia Ltd. 
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1.3  About Cnario Messenger 

The Cnario Messenger digital signage solution includes a comprehensive suite of software products designed to display 

targeted pixel-perfect digital media on digital signage networks. Typically, this includes network management and 

screening of media and promotional material on digital signage displays in retail and recreational environments, as well 

as public spaces such as supermarkets, shopping malls, bars, airport and rail transport terminals and museums. 

Cnario Messenger features include content management, layout (canvas) authoring, network management and 

playback enhancements. Together, this functionality provides an intuitive production, distribution, display and 

management system for screening digital dynamic media spots on wide area digital signage display networks. 

 

1. Introduction 

1.1 Document Scope 

This User Guide describes how to use the Cnario Messenger digital signage solution to design, deploy, monitor and 

control playback canvases. The guide presents the basic procedures for each module, as well as the advanced features 

and components, providing you with a complete understanding of the solution capabilities. 

1.2 Related Documentation 

Advanced usage is covered in additional guides and in Messenger College courses listed in the following table.  

Document Description 

Cnario Media Manager How to set up and use Media Manager to update multimedia displays 

via the Internet. 

Cnario Getting Started Operation Manual  
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1.4  Terminology and Basic Concepts 

Digital signage often includes a group of display devices (screens / projectors) combined to form one large display 

area. 

The following is needed to create a digital signage display: 
 

Canvas - Refers to each display area, consisting of one or 

more channels. 

Screen - Refers to the display device(s) that make up the 

canvas. 

Player - Refers to the unit responsible for playback. The 

player receives displays sent through the Channels and 

projects it to the screen(s). 

Channels - Refers to the physical output of a player 

computer. 

Pins - Parameters associated to the playback devices. Pins 

can be configured to receive real time data and manage 

your players. 

Projects - Contain the layouts. You can create multiple 

projects to sort your layouts into different groups. 

Folders - Project folders are configured and added in 

Messenger. You can access and add content to these 

folders, or add new folders to sort content items. 

Folders - Add folders to your project to sort your layouts into sub-groups. 

Layout - Represents the canvas in Messenger. You design the layout in the way you want to present your content on 

the canvas. 

Windows - Hold content items and are placed inside the layout. 

After you create a layout with windows designed, placed and layered, you assign content items to the windows. 

Playlist - Used to play multiple content items, consecutively, in a single window. 

Schedules - Defines, in advance, the specific times or logic for certain content to be played. Schedules can be added to 

layouts, library items and pins. 
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2. Getting to Know the User Interface 

The user interface consists of the following main parts: 

In Messenger, you can perform many of the tasks using more than one method. The main methods are (with 

associated icon): 

 Menu Toolbar button ) 

 Command Toolbar button ) (in Edit Module, may also refer to the layout or the resources toolbar) 

 Context menu (right-click) ) 

 Keyboard shortcut ) 

 

 

 

 

Menu Toolbar - contains various menus with common actions 

Mode Toolbar - contains buttons for switching between modes 

Command Toolbar - contains buttons for performing tasks in the current mode 

Main Work Area - main workspace where you perform tasks 

The interface, including menu options, is dynamic and changes according to the mode selected in the Mode Toolbar. 

2.1  Using Multiple Methods to Perform  Tasks 
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In this guide, procedures are demonstrated using the recommended method. Tasks that you can perform using 

additional methods are marked with the relevant icons to the left of the task. For  example: 

 1. In the Menu Toolbar, click File, then click Add Layout. 

2.1.1 Examples of Tasks Performed Using Different Methods 

2.1.1.1 Adding a Layout 

You can add a new layout to a project using one of the following methods: 

Method 1: Menu Toolbar 
 

In the Projects pane, click the project in which you want to add the layout. 

In the Menu Toolbar, click File, then click Add Layout. 

Method 2: Command Toolbar 

1. In the Projects pane, click the project in which you want to add the layout. 

2. In the Command Toolbar, click (Add), then click Layout. 

Method 3: Context Menu 

In the Projects pane, right-click the project in which you want to add the layout. 

Click Add Layout. 
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2.1.1.2 Editing Window Properties 

You can edit window properties using one of the following methods: 

Method 1: Properties Pane 
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In the Layout Toolbar, click (Toggle Edit mode) and then click 

(Window Properties) to display the Properties pane, then click the field you want to 

edit and enter a value. 

Method 2: Context Menu 

In the Layout Toolbar, click (Toggle Edit mode) and the right-click the window,

then click Properties to open the properties dialog box. 

Method 3: Command Toolbar 

Click the window, then in the Command Bar, click (Show Item Properties) 

to open the properties dialog box. 
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2.1.1.3 Transferring Layouts 

Method 1: Menu Toolbar 
 

In the Projects pane, click the layout you want to transfer. 

In the Menu Toolbar, click File, then click Transfer Layout. 

Method 2: Command Toolbar 

1. In the Projects pane, click the layout you want to transfer. 

2. In the Command Toolbar, click (Transfer Layout). 
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3. Setting Up the Network 

3.1 Defining the Messenger Network 

To define the Messenger network 
 

1. In the Menu Toolbar, click Tools, then click Preferences to open the 

Preferences dialog box. 
 
 
 
 

 

2. In the Network tab, in the Transporter section, 

click Graphical Tree Edit. 

If you install Messenger and Player on the same computer, in the Messenger Chainmail section you must 

select Secondary. 

The Chainmail Tree Editor opens. The (Arrow) is 

active by default, and the local machine icon appears in 

the network screen. 
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Click the Messenger icon to display the Misc pane 

detailing the Designation, IPAddresses, and Node 

Type. 

In the Misc pane, click Designation and change the 

default (Messenger) name. 

Click Node Type, then select Server from the drop 

down list. 

If any of the field information is incorrect or missing it can be added to or edited. 

To add and configure the nodes 

1. Click (Node), then click anywhere in the 

network screen. A new node (player) icon is added 

to the layout. 

2. Click the (Arrow), then click the (New 

Node) icon to activate it for configuring. 

3. In the Misc pane, click Designation and change the

default name to correspond to the Local 

Designation name of the (remote) Canvas node, for 

example, QUAD. 

3.2 Building the Network Structure 

Use the Chainmail Tree Editor for the graphical deployment of the network players (nodes) included in the 

Messenger digital signage network. 

This section describes the work flow required to build the network structure. 

The work flow consists of the following main procedures: 

1. Set the server details. 

2. Add and configure the players. 

3. Link the server to the players, then set the link type. 

4. Import the ChainMail Channels. 

To set the server 
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8. Repeat steps  1 to 7 above to add more players to the network layout. 

To link the server to the nodes 

1. Click the (Link), then click the (Server) 

icon. Drag the selected icon to the node you 

created. An active communications link between 

the two nodes is created. 

The network is configured and the File Link pane is 

opened. 

2. Set the communication link type: 

 

4. Click IPAddresses, then click  (Browse), to open the IP List Editor dialog box. 

5. In the IP List Editor dialog box, select an existing IP address in the top pane or to 

add a new IP address: 

a. In the bottom pane, type the IP Address. 

b. Click Add, then select the added address. 

6. Click OK. 

7. In the Misc pane, click Node Type, then select one of the following icons from the drop-down list: 

Ẽ Node 

Ẽ Gateway 

Ẽ Server 
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In General, click Link Type, then select from 

one of the following: 

Message - Establishes a bidirectional link 

that enables the Control Station to send 

messages to the player and vice-verse. 

For example: a. A message from the 

player to the Control: "I am alive"; "I'm 

playing Layout X". b. A message from the 

Control to the player: "what layout are 

you playing?" 

File - Establishes a unidirectional link that 

enables files, for example a video file that 

is set to play in the window of a layout, to 

be sent from the Control Station to the 

player. 

FileMessage - Enables both of the above 

Link Type functions. 

Communications link types can be set between a Control Station and a player, or between any two 

network players that have Messenger Control Station or player applications installed on them. 

 
3. In Misc, set the Active setting to True. 

4. Click (Save) to save your local network settings. 

5. Close the ChainMail Tree Editor dialog box, then yes for the confirmation message. 

To import ChainMail Channels 

1. In the Mode Toolbar, click (Device Manager). 

2. In the Channels pane, right-click the Canvases tree, then select Import 

ChainMail Channels to open the Import Chainmail Channels dialog box. 
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Select the check boxes of the required players for 

example, QUAD and check the display device 

(canvas) you require, for example Canvas Controller 

1. 

Click Import. 

The player will appears as connected in the Channels pane in the network module. 

Your Local Network is now set up. You can continue to add additional nodes and expand the Local Network 

as required. 
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4.  Authoring Content 

The Edit Module is where you manage and author your content. 

To enter the Edit Module, in the Mode Toolbar, click  (Edit Module). 

4.1  Edit Module 

The Edit Module interface consists of the following parts: 

The Projects pane displays the projects, folders and layouts in a hierarchical order. 

 Use the Search field at the top of the pane to search for elements in the Projects pane. 

 To show or hide the Projects pane, in the Command Toolbar, click  (Show / Hide Projects). 

4.3 Edit Area 

The Edit Area consists of the main workspace where you edit the layout, and the Layout Toolbar which contains 

various commands to perform in the layout. 

4.2  Projects Pane 
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Creating a Content Item 

Assigning Content Items to Windows 

4.4 Resources Pane 

. The Resources Toolbar, located under the tabs, contains various commands for use with content items. 

 To show or hide the Resources pane, in the Command Toolbar, click  (Show / Hide Resources). 

4.5 The Workflow 

Content authoring consists of the following steps: 

1. Adding a Project and a Layout 

2. Creating Windows 

3. 

4. 
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4.6 Working With Projects and Layouts 

4.6.1 Adding a Project and a Layout 

The first step in authoring your content is adding a project and then a layout. You can add a single screen layout, or you 

can add a multi-screen layout. Select the multi-screen layout for playback on a canvas with multiple screens. The 

multiscreen wizard will help you build a layout with the correct number of screens and incorporate the bezel (spaces 

between the screens). 

You can also create folders in your project to organize your layouts in the project. 

To add a project 

1. In the Command Toolbar, click (Add), then click Project. 
 
 

2. Type a name for the project, then press Enter. 

To add a folder (optional) 

1. 

2. 

In the Projects pane, click the project in which you want to add the new folder. 

In the Command Toolbar, click (Add), then click Folder. 

3. Type a name for the folder, then press Enter. 

To add a layout 

1. In the Projects pane, click the project or folder in

which you want to add the new layout. 

2. In the Command Toolbar, click (Add), then click 

Layout. The Layout Properties dialog box appears. 
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In the Schedule tab, add a playback schedule to the layout (optional). See Section 6.2.3 (Configuring a Schedule) 

on how to create and add a schedule to the layout. 

In the Keywords tab, set the Layout Priority, click the Change Keywords button, then select the keywords you 

want to link to the layout (optional). See Section 6.4 (Applying Playback Rules with Keywords). 

In the Associated Layouts tab, in the Layouts box, select an existing layout you want to link to your new layout, 

then click Add (optional). 

The player will automatically load associated layouts into the player memory when this layout starts 

playing. This will improve the speed / transition between layouts. However, preloading the layouts will 

consume more of the ǇƭŀȅŜǊΩǎ memory. 

Layout properties are described in the following table: 
 

Field Description 

Resolution Select or type a layout resolution in the format of <width> X <height>. 

 
The layout resolution should match the resolution of the screen (or 

multiple screens) that displays the content. 

Align To Grid Displays a grid in Edit Mode, to allow alignment of the windows by snapping them 

to the grid. 

Horizontal and Vertical defines the grid size. 

Background Select one of the following background options: 

Background Image - Select an image to display as the background to your layout 

Background Color - Select a color to display as the background to your layout. 

Jump Start Used for dynamic content, allows you to select the point from which you want 

the layout to start playing. 

Auto Deletion Select one of the following options for deleting the layout: 

Ẽ Never delete - Retains it infinitely. 

Ẽ Delete when not in use - deletes it when its no longer playing. To 

automatically delete unused content from the player you must also 

configure the player, see Section 8.2.8.1.1 (Auto-Deleting Unused Media 

Files). 

Ẽ Delete if not in use after - deletes it on the date you set. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click OK. 

4.6.2 Performing Additional Tasks on Projects and Layouts 

You can perform additional tasks with projects and layouts such as delete, rename, copy, etc. by clicking the command 

buttons in the Command Toolbar, or by right-clicking the project or layout in the Projects pane. 
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4.7 Editing Layout Windows 

The following sections describe the basic operations required to design the windows in your layout. 

4.7.1 Edit Mode 

When you work on a layout, you can work in either of the following modes: 

 Edit Mode active - For editing windows design properties (such as size and position). 

 Edit Mode inactive - For content related properties and tasks (such as assigning content items, managing playlists 

in the windows). 

To toggle Edit Mode on or off, in the layout toolbar, click (Toggle Edit mode). 
 

 

When Edit mode is active, windows appear in blue, and selected windows appear in 

purple. 

To select multiple windows 

Hold down the Ctrl while clicking the windows. The selected windows 

are pink, and the last window you select is purple. 

When Edit Mode is inactive, the windows display a thumbnail of the content items 

that are assigned to them, or they appear in green if no content item is assigned. 

 

The tasks in this chapter are demonstrated using the Properties pane. Therefore, while performing the 

steps in this chapter, make sure the Properties pane is displayed while Edit Mode is active. To toggle the 

Properties pane on or off, in the Layout Toolbar, click (Window Properties). 
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4.7.1.1  Creating Windows 

To add a window to your layout 

1. Make sure Edit Mode is active (as described in Section 4.7.1). 

2. If the Properties pane does not appear to the right of the layout, in the Layout Toolbar, click 
 

(Window Properties) to display it. 

3. To create a window, perform either of the following: 

Ẽ In the Layout Toolbar, click (Create a New Window). A new window 

appears in the upper left corner of the layout by default. 

 
 
 
 
 

 

Ẽ Click a blank spot on the layout background and drag to create a window 

in the size you want. 

 
 
 
 

 

  

4.7.2 Changing Window Properties 

To change window properties 

1. Make sure Edit Mode is active (as described in Section 4.7.1). 

2. If the Properties pane does not appear to the right of the layout, in the Layout Toolbar, click 
 

(Window Properties) to display it. 

3. Select the window using either of the following methods: 

Ẽ Click the window in the layout in the Edit Area. 

Ẽ Click the window in the Projects pane, in the 

windows list under the layout (this method is 

mainly useful if you use window layering). 

 

Both methods can be used to select the 

window, or to open its context menu by 

right-clicking. 
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4. To rename a window: 

Select the window. 

In the Properties pane, click Name. 

Type the window name. 

To enter a window description: 

Select the window. 

In the Properties pane, click Description. 

Type the window description. 

To set the window size, perform one of the 

following: 

Drag the edges of the window. 

Select the window, then in the Properties 

pane, type the pixel sizes in the Width and 

Height fields. 

 

7. To lock the aspect ratio of the window size, right-click the window, then click

Lock Aspect. You can also select one of three predefined ratios (1:1, 4:3 or 

16:9) from the menu. 

When you click one of the predefined ratios, the Lock Aspect option is 

automatically enabled. To unlock the aspect ratio, right-click the 

window, then click Lock Aspect to remove the check mark. 

To change the window position, perform one of the following: 

Drag the window. 

Select the window, then in the Properties pane, type the pixel distance from the layout top in the Top field, 

and the pixel distance from the layout left edge in the Left field. 

To prevent unintentional changes to the window size and position, right-click the window, then click Lock 

Window. 
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4.7.3 Window Layering 

You can place multiple windows on top of each other to 

create window layers. For example, use a window as the 

layout background, and place another window on top of 

it to display content. 

Set the layering by using the window Depth property, 

where 0 is the front window, and 99 is the back window 

(default value = 50). 

To set window depth 

1. Select the window. 

2. In the Properties pane, type a value in the Depth 

field. 
 

4.7.4 Window Aligning and Relative Resizing 

In the layout toolbar, you can use the aligning and 

resizing command buttons when you want to align 

multiple windows relative to each other, or to assign 

them the same size. 

  
  
  
  
 
   
   
  

To align or resize windows   

1. Select the windows you want to align or resize, by 

holding Ctrl while clicking the windows. The last 

window you select is colored dark purple and 

serves as a point of reference when using the 

aligning and resizing commands. 
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Stored media (such as videos and images) 

Dynamic content (such as RSS feeds) 

Applications (such as HTML5, Flash) 

4.8.1  The Resources Pane 

Both options for creating content items are represented in the Resources pane by the following tabs: 

Layout - Displays all content items that are included in the current layout. 

Library - Displays the content items library. 

When you create a new content item using the Resources pane, the selected tab determines whether it is created in 

the library or in the layout. 

 

2. In the Layout Toolbar, click the matching command 

button to set the windows position or size as you 

want (hover over a command button to display its 

description). 

 
 
 
 
 
 

4.8 Adding Content Items 

The next step after designing the layout windows, is to add your content to the layout. In Messenger, each piece of 

content, with its properties, is defined as a content item. Content items may belong to one of the following types: 
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1. In the Resources pane, select the Layout tab or the Library tab, according to where you want to create the 

content item. 

2. If folders are used, click the folder in which you want to add the content item. 

3. In the Resources Toolbar, click (Add Item). 

When you work in a certain layout, the Layout tab also 

displays library-linked content items that are used in 

that layout. These items are marked with (L) at the end 

of their name. This indicates that the content item is 

linked to the library and is not a layout item. 

You can arrange your content items in different folders. If folders are used, the Resources pane is divided into two 

parts, displaying a folder tree on the left side, and content items from the selected folder on the right side. 

The Resources Toolbar contains command buttons for performing various tasks in the Resources pane (such as create 

a new folder, copy or move content items to different folders, change the view mode of the content items). 

Advanced library tasks are described in Section 7 (Adding Advanced Content Item Types). 

 
4.8.2  Creating a Content Item 

The following procedure describes how to add an image type content item. For information on other types of content 

items, see Section 5.1. 

To create a content item 
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4. From the drop-down menu, select Image. The Picture Properties dialog box 

appears. 

5. Click  (Browse), then select the image file you want to add. 

6. Click OK. 

 
 
 

 

4.8.3  Assigning Content Items to Windows 

To assign a content item to a window 

1. Make sure Edit Mode is inactive (as described in Section 4.7.1). 
 

2. Drag the content item from the Resources pane to 

the window. 

You can drag multiple content items to a window to 

create a playlist, as described in detail in Section 6 

(Managing Playlists and Schedules). 

3. If you assign a content item from the library, the 

Drag-Drop Mode dialog box appears. For 

information on the dialog box, see Section 4.8.3.1 

(Creating Linked Content Items) below. 

 
4.8.3.1 Creating Linked Content Items 

 

When you assign a content item from the library, a 

dialog box appears asking you to select one of the two 

options described in Section 0.1 (Options for Creating 

Content Items): 

Ẽ Create Link - Select this option to assign the 

content item as a Linked Content Item. This 

means, any changes you make to the content 

item in the Library will affect the item in the 

layout. 

Ẽ Create Copy - Select this option to copy the content item to the layout as a new Layout Content Item. This 

means, any changes you make to the content item in the Library, will not affect the item in the layout, 

because it is not linked to the library item. 

 
To select a mode 

1. Next to Drag-Drop Mode, select the mode you want to use for the current content item. 

2. If you want to set your selection as the default option for the current content item type, select the Always do this 

action check box. 

 

For information about the resize feature, see To add an image item. 
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3. Click OK. 
 

4.8.3.2 Disconnecting a Linked Content Item 

If a certain layout contains a Linked Content Item, you can remove the link at any point to disconnect the content item 

from the library and turn it to a Layout Content Item. 

To disconnect a Linked Content Item 

1. In the Resources pane, under the Layout tab, locate the Linked Content Item. 

 

To reset or change default options, in the Main Menu click Tools->Preferences->Drag-Drop and select the 

default action for Drag-Drop mode. 

In the Layout tab, Linked Content Items are marked with (L) at the end of their name. 

 
2. Right-click the item, then click Disconnect from Library. 

If you want to make changes to a Linked Content Item, you must 

perform the changes from the library. Otherwise, the link will be 

automatically removed. 
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1. In the Menu Toolbar, click Tools, then click Preferences to open the 

Preferences dialog box. 

Click the Canvas Controller Preview tab. 

Select the Enable Canvas Controller Preview check box. 

Select the Windowed Preview check box to override the resolution dimension, then set the size of the preview 

window. 

CƻǊ ōŜǎǘ ǇǊŜǾƛŜǿƛƴƎ ŜȄǇŜǊƛŜƴŎŜΣ ƳŀǘŎƘ ǘƘŜ ǇǊŜǾƛŜǿΩǎ ŘƛƳŜƴǎƛƻƴǎ ǘƻ ƭŀȅƻǳǘΩǎ ŀǎǇŜŎǘ ǊŀǘƛƻΦ 

 
5.    Click OK. 

4.10  Layout Thumbnails 

To help you identify layouts quickly, you can assign a 

thumbnail to each layout. The thumbnail will appear 

when you select in the Projects pane the project or 

folder containing the layout. 

To set a layout thumbnail 

1. Open the layout for which you want to set the

thumbnail. 

4.9  Previewing Layouts 

After you finish editing your layout and adding your content, you can see a preview of the layout. 

To preview the layout 

1. In the Command Toolbar, click (Preview). 
 

2. Press Esc to close the preview window. 

4.9.1 Adjusting the Preview Window Dimensions 

You can adjust the dimensions of your preview window to ensure that the preview window reflects the same aspect 

ratio as the screens the display will be played on. 

To set the preview window dimensions 
 
 
 
 

 
 
  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2. Set the layout in the state you want for the 

thumbnail (i.e. with Edit Mode active or inactive, or with certain content items selected). 

3. Click (Capture Layout Thumbnail) to set the current state as the layout thumbnail. 
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5.  Managing the Library 

Add content items directly to the Library pane for use in one or more windows, and in one or more layouts. Making 

changes to a content item in the library will automatically enforce that change to item in all the layouts / windows 

where it has been used. 

5.1  Content Item Types 

This section describes how to add the following basic types of content items to the library: 

 Audio 

 FlashHTML5 

To add an audio item 

1. In the Layout or the Library tab, click (Add Item), then click Audio. 

 

 

 

 

 

Image 

RSS 

Windows Media Streaming 

Text 

Video 

Advanced content item types are described in the Section 7. 

 
5.1.1  Audio 

You can add audio items to provide playback music or sound while other content items are displayed. Messenger 

supports the following audio formats: 

 

 

 

 

 

.mp3 

.m2v 

.mp2 

.wav 

.wma 

Adding an audio item is done through the Fleximedia dialog box. This allows you to treat the audio track of 

a multiplexed audio-video file as an audio item. You can choose whether to include the video with the 

audio playback. 
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Force Mapping is an optional setting targeting custom-made audio mapping. 

 
In Volume (%), set the volume. 

Click Play to listen to your track. 

Click OK. 

5.1.2  Flash 

You can add Adobe Flash animation items to be played on screen. This includes: 

 

 

 

Basic Flash animation 

Dynamic Flash (able to read data from an external dynamic source) 

Interactive Flash (enables user interaction using a mouse or touch screen). 

Messenger supports the .swf Flash file format only. 

To add a Flash item 

1. In the Layout or Library tab, click (Add Item), then click Flash to open the Flash CI dialog box. 

In the SWF File box, click (Browse), select a Flash file, then click Open. 

Select the options according to the following table: 

 

2. Select your audio item, then click Open to open the 

FlexiMedia Master dialog box. 

3. Click  (Browse) to add more audio files. A 

thumbnail of each file will be listed in the left hand 

pane of the FlexiMedia Master dialog box. 

4. In the Item Name box, type a name for your file. 

5. In the Media Streams box, select the audio stream 

check box, then click on the audio stream text. 

6. If you have customized audio output targets, in the 

Force Mapping box, select an output. 
 
 
 
 
 
 
 
 
 
 
 
  
  

 
 
 

 
 

 
 
  
 
 
 
 

 

Option Description 

Movie Mode Use with frame-based Flash files that were created as video-like 

animations. 

Infinite Mode Use with Flash files that were created as an interactive application or 

as an animation with multiple time lines (identifies itself as a one 

frame long file). 

Ignore Stop Command Use when Infinite Mode is selected. If a Stop command is part of an 

active action script, enabling this option will keep playing the item 

when called. 

Transparent Flash Select this option only when necessary, as it requires additional sys- 

tem resources and may reduce performance. 
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Option Description 

Render Zoom (%) Changes the size of the rendered animation (when set over 100% it 

reduces quality and improves performance). 

Set Thumbnail Sets the thumbnail image for the Library item. 

Exposed Variables When global variables are enabled with the Flash program, they can 

be exposed over the 'Devices' interface. 

Copy to Original Location If additional files are needed to run a Flash application, and if a cer- 

tain structure is imposed, this box ensures all files are copied to the 

same path on the player as they are loaded from (requires having the 

same drive letter available on the player machine). 

4. If there is .xml or related dynamic data the Flash needs to read from, add it in the Tag Along Files section of the 

settings window. 

5. You can preview the Flash file by clicking Play. 

6. Click OK. 

5.1.3  HTML5  

You can add local and remote HTML5 items. Playback of HTML5 content in the Messenger environment requires 

special care and consideration compared to playing the same content inside a browser. 

Please contact YCD support (supportUS@ycdmultimedia.com or supportINT@ycdmultimedia.com) for version-specific 

guidelines and visual verification tools for HTML applications. 

To add HTML5 content 

1. In the Layout or Library tab, click (Add Item), then click HTML5 to open the HTML5 CI Master dialog box. 
 

2. In the Item Name box, type a name. 

3. In Item Duration, type or select the length of time you want the HTML5 item to play. 

4. Add HTML5 content from one of the following sources: 

Ẽ Remote HTML5 content 

Ẽ Local HTML5 content 

5. In the Rendering section, you can select from the following options: 
 

Option Description 

Prefer GPU Acceleration Set higher priority for GPU processing power over CPU processing 

power. 

Allow Transparency Allows alpha-keying of HTML items over other layers. 

Use this option only when necessary, as it requires additional system 

resources and may reduce performance. 

Force Rendering Size Forces the media item to fit the layout window by adjusting the Pixel 

sizes. 

Frames / second Increases or decreases the speed of the frames. 

6. In the Failover and Recovery section, select the Enable check box, then set the testing, failover, and recovery 

times. 

mailto:supportus@ycdmultimedia.com
mailto:supportint@ycdmultimedia.com
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7. In the Test URL box, paste or type the URL site to be tested. 

8. Leave the Failover URL box blank to use as the primary URL, or add a new URL to be used in case of a failover. 

9. Click OK. 

To add remote HTML5 content 

1. In the HTML5 CI Master dialog box, select URL, then paste or type in the web address in the box. 

2. Click Inspect HTML. Status: OK will appear at the bottom of the window if the link works. Status: The remote 

server returned an error will appear if the link does not work. 

3. Select the User / Password Authentication box, then add the necessary credentials for a secured HTTP 

connection. 

To add local HTML5 content 
 

2. To resize the image, before you open the image, perform the following steps: 

a. Select Auto Resize Images, then set the size and format you want for the image. Using this option will 

generate a new copy of the image. 

b. To save the image in a different format, click the Resized Image Format arrow, then click the required 

format. 

3. In Location, click  (Browse), select an image file, then click Open. 

4. Click OK. 

In the HTML5 CI Master dialog box, select File, then click (Browse) 

In the Select HTML Local File dialog box, select an HTML5 file, then click Open. 

5.1.4  Image 

You can add high resolution images for pixel perfect play. Messenger supports the following formats: 

 

 

 

 

 

 

 

.bmp 

.tga 

.jpg 

.png 

.gif 

.tif 

.tiff  

The .png and .tga playback also enables playback with transparency features (alpha canvas). 

The image properties can also be edited to change the aspect ratio and create images that scroll across the window. 

To add an image item 

1. In the Layout or Library tab, click (Add Item), then click Image to open the Pictures Properties dialog box. 
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Set the Direction, Speed and Gap Size of the ƛƳŀƎŜΩǎ movement across the window. 

Click OK. 

5.1.5  RSS 

You can add Rich Site Summary (RSS) items to deliver regularly changing web content such as news sites, web blogs, 

weather, sports results, etc. This is the ideal tool for adding the timely delivery and playback of eye-catching, topical 

messaging to existing scheduled layouts. 

Messenger can read common RSS feed from the web, including: 

 

 

 

 

 

 

 

Attached media images 

Item images 

Media items (video, Flash and audio) 

Canvas titles 

Item titles 

Canvas descriptions 

Item descriptions 

To set the image aspect ratio and scroll it across the window 

1. In the Library, right click on the content item thumbnail, then click Playback Properties to open the Playback 

Properties dialog box. 

2. In Picture Behavior, set the aspect ratio from one of the following options: 

3. In the Image Properties section, in Behavior, select one of the following aspects: 
 

Option Description 

Keep Aspect Retains image's default settings. 

No Scaling Maintains image's aspect ratio. 

Ignore Aspect Stretches image over the entire window, may cause changes to 

aspect ratio. 

Maximize X Stretches image horizontally. 

Maximize Y Stretches image vertically. 

 
 
 
 
 
 
 
 
 
 
  
  
  
 
 
 
 
 
 
 
 
 

It can also display feeds as crawling text in the displayed layout, and fits the standard feed found on the web. 

To add an RSS item 

1. In the Layout or Library tab, click (Add Item), then click RSS to open the RSS Master dialog box. 
 

2. In the Link tag, in the Link box, type or paste the URL link of your RSS feed, then click  (Reload RSS). The 

available image and text from the RSS feed file link will appear. 

3. You can click (Open link in browser) to open the link in Internet Explorer. 

 

The player must maintain constant access to the Internet during the RSS display or information may 

become outdated. 
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See Window Aligning and Relative Resizing for a description of each aligning tool. 

To add an RSS window 

1. 

2. 

In the Editor Size section, type or select the size of the editor to fit the actual window it will be placed on. 

Click (Create a New Window). 

3. In the Continuous Scroll / Crawl Mode section, set the options according to the following table: 

4. Click OK to save and close, or the Windows Editor tab. 
 

5.1.5.1 Windows Editor Tab 

Add and organize your RSS content into windows in the Windows Editor tab. 

In the Windows Editor tab. The following options will appear on the windows tool bar: 
 

Option Description 

 (Show Windows List) Provides a list of all windows. 

 (Create a New Window) Creates a new window. You can create multiple windows. 

 (Show Window Properties) Shows window properties. 

(Zoom) Zooms in or out (in percentages %). 

(Delete window) Deletes highlighted window. 

(Lock All Windows) Locks all the windows in the layout so you cannot add more changes. 

(Unlock All Windows) Unlocks all the windows in the layout, so you can make more 

changes. 

(Move Left) Moves the highlighted window to the left. 

(Move Right) Moves the highlighted window to the right. 

(Move Up) Moves the highlighted window up. 

(Move Down) Moves the highlighted window down. 

 
 
 
 
 
 
 
 

 

Option Description 

Direction Allows you to choose the direction the text will move across the win- 

dow. 

Duration Allows you to determine the length of time (in seconds) it takes for 

the text to move across the window. 



 

40 | Cnario Messenger 3.8.5        Updated: November 2019 

 

Option Description 

Gap Allows you to determine the gap (in percentage relative to window 

size) between text appearances. A 100% gap means that the next 

item will appear only when the last one has finished playing. 

Auto Resize This option is grayed out if any motion is selected. This advanced 

feature is usable only in Static mode Direction. Using this selection 

you can auto resize the rendering Vertically or Horizontally. 

Alternatively, you can choose not to auto resize the item by selecting 

None, (which will show only the rendered text that fits in the 

designated window). 

 

The Auto Resize is an advanced feature and is to be used only if the item is located inside a sequence item 

and has received motion and filter manipulation via the sequence and not via the selection. 

 

4. Add one of the following to each window: 

Ẽ Text 

Ẽ Dynamic Text from RSS Link 

Ẽ Image 

Ẽ Dynamic Image from RSS Link 

 

5. Click OK to save and close, or click the Preview tab. 

To add text to a window 

1. Click on the window you wish to use. 

2. Click (Show Window Properties) to open the Window Properties dialog box. 

 
3. In the Name box, type a name for the selected window. 

4. In the Windows Properties section, in the Type list, select Text. 

5. In the main window, type the text you want to appear. See To add a text item for additional text formatting 

options. 

6. In the Windows Position section, in the Top, Left, Height, and Width boxes type or select the size and position of 

the window. 

To add dynamic text to a window 

1. Click on the window you wish to use. 

2. Click  (Properties) to open the Window Properties dialog box. 

3. In the Name box, type a name for the selected window. 

4. In Type, click Text From Tag. 

5. In Tag, select one of the following: 
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Click on the window you wish to use. 

Click (Show Window Properties) to open the Windows Properties dialog box. 

 
In the Name box, type a name for the window. 

In the Windows Properties section, in the Type list, select Image. 

In the Static Image box, click (Browse), select an image, then click Open. 

In the Image Properties section, in Behavior, select one of the following aspects: 

In the Image Properties section, in Alignment, select the position of the image within the window. 

In the Windows Position section, in the Top, Left, Height, and Width boxes type or select the size and position of 

the window. 

To add a dynamic image to a window 

 

Option Description 

Canvas- Each canvas describes the RSS feed. 

Canvas Title Defines the title of the canvas. 

Canvas Description Describes the canvas. 

Item - Each item defines a "story" or article in the RSS feed. 

Item Title Defines the title of the item. 

Item Description Describes the item. 

Item Title & Description Combination of the item's title and description. 

See To add a text item for additional text formatting options. 

To add an image to a window 
 
 
 
 
 
 
 
 
 
 
 

Option Description 

Keep Aspect Retains image's default settings. 

No Scaling Maintains image's aspect ratio. 

Ignore Aspect Stretches image over the entire window, may cause changes to 

aspect ratio. 

Maximize X Stretches image horizontally. 

Maximize Y Stretches image vertically. 

 
 
 
 
 

 

1. Click on the window you wish to use. 

2. Click  (Properties) to open the Window Properties dialog box. 

3. In the Name box, type a name for the selected window. 

4. In Type, click Image From Tag. 

5. In Tag, select one of the following: 
 

Option Description 

Image Canvas image, taken from the RSS feed. 

Item Image Image per item taken from the RSS feed. 
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Option Description 

Item Media A media item with its metadata (audio, video and image), taken from 

the RSS feed. 

6. In the Image Properties section, in Behavior, select one of the following aspects: 
 

Option Description 

Keep Aspect Retains image's default settings. 

No Scaling Maintains image's aspect ratio. 

Ignore Aspect Stretches image over the entire window, may cause changes to 

aspect ratio. 

Maximize X Stretches image horizontally. 

Maximize Y Stretches image vertically. 

7. In the Image Properties section, in Alignment, select the position of the image within the window. 

8. In the Windows Position section, in the Top, Left, Height, and Width boxes type or select the size and position of 

the window. 

5.1.5.2 Anchoring Two Windows 

When you set the properties for your windows, you have the option to anchor adjacent windows, horizontally and / or 

vertically. By anchoring the windows, you ensure their content is synced and their positions remain next to one 

another even if the content duration or size of the windows change. 

To add a horizontal anchor 
 

1. Make sure you are clicked on the left window in your layout, then click 
 

(Show Window Properties). 

2. Scroll down to the Windows Anchoring section, then select the Horizontal 

check box. 

3. Click the drop-down arrows to anchor the Right window to the Left window. 

4. In "of", select the window you want anchored. 

To add a vertical anchor 
 

1. Make sure you are clicked on the upper window in your layout, then click 
 

(Show Window Properties). 

2. Scroll down to the Windows Anchoring section, then select the Vertical 

check box. 

3. Click the drop-down arrows to anchor the Bottom window to the Top window. 

4. In "of", select the window you want anchored. 
 

5.1.5.3 Preview Tab 

You can preview your RSS link in the Preview tab. 

To preview your RSS feed 

1. In the Preview tab, select the following options to adjust your preview: 
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To set the appearance of your RSS feed 

In the Settings tab, select one of the following options: 

Show all items to present all the items available in the same page together. 

Loop Items to loop one or more items per page. Use this option to select the media items to play. 

Loop items can provide a more organized presentation than the Show all items option, which may load the 

viewer with unorganized, cluttered information. 

 
2. Set the other options as required (see table below): 

 

Option Description 

 (Change Preview Zoom) button Adjusts the appearance size of the feed. 

 (Change Preview Background Color) Adjusts the background color. 

(Next Result) Skips to the next tag. 

2. Click OK to save and close, or click the Settings tab. 
 

5.1.5.4 Settings Tab 

You can set the appearance of your RSS feed in the Settings tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Option Description 

Use Web Cache Presents saved Web Cache when the Internet is offline. Do not select 

this option for real-time information, such as stocks and traffic. 

Separators Creates a visual separator between feeds. 

Select text or a symbol (such as ------->>>) to create a visual 

separation. 

Read Interval Sets the duration (in seconds) between updates. 

Restart when available Restarts the RSS item whenever RSS content is updated, without 

waiting for the whole loop to play. 

Delete unused cached media if not used in 

the last 

Type or select the number of days. 

Disregard extra media files info Discards additional files information such as RSS hash codes. 

Loop Items You can select which media items to download and play from the RSS 

source. 
 

To select which media items to play 

1. Select the Loop Items option. 

2. In the Include item media of type section, select any combination of Image, Video, Audio, or Flash streams that 

you require. 

3. Select the Merge with text and Image boxes to play the image media item within the text. This will cause the 

image media item to play in another window in the RSS media item (with parameters of Image from tag). 
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6. Click OK to save and close, or click the Default Tags Values tab. 
 

5.1.5.5  Default Tags Values Tab 

Set the default tag values for the RSS item in the Default Tags Values tab. These values will be displayed during the 

sequence editor preview when RSS results are unavailable. 

To set the default tag values 

1. In the Default Tag Values tab, highlight the tag by clicking on it. 

2. In the Tag Value column, double click on the cell, then type in a value. 

3. Repeat steps  1 and  2 above for each additional tag. 

4. Click OK to save and close, or click the Web Access tab. 
 

5.1.5.6  Web Access Tab 

You can set an Internet proxy for your feed in the Web Access tab. 

To set a proxy 

1. In the Web Access tab, select the Use Proxy check box. 

2. In the Host box, type a host. 

3. In Port, type or select a number. 

4. In the Play on window box, type the name (case sensitive) of the layout window you want the media item to play 

on. Use this option to play the item in a layout window that is not set in this RSS item. 

5. Set the scaling by selecting one of the options in the Scaling menu: 
 

Option Description 

Default Retains image's default settings. 

Keep Aspect Maintains image's aspect ratio. 

Ignore Aspect Stretches image over the entire window, may cause changes to 

aspect ratio. 

Maximize X Stretches image horizontally. 

Maximize Y Stretches image vertically. 

Zoom to window Stretches the image to fit the window. 

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. To insert a user name and password for the proxy: 

a. In the Proxy Password section, select the Use Password check box, then type a User Name and Password. 

5. Select the Domain check box (optional), then type a domain name. 

6. Click OK. 
 

5.1.5.7  Save Settings for Re-use 

You can save your RSS settings locally for re-use on additional RSS items. 

To save your settings for re-use 

1. Click (Save Settings) to open the Save As dialog box. 
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5.1.6  Text 

You can add a text to display messages. The text items can be displayed as static, crawling or scrolling. Text can be 

uniformly altered for: 

 

 

 

 

Fonts 

Colors 

Shadows 

Outlines 

2. Select a local location, then in File Name type a name for the RSS settings. 

3. Click Save. 

To re-use your saved settings 

1. In the Layout or Library tab, click (Add Item), then click RSS. 
 

2. Click (Load Settings), locate and click on the RSS file, then click Open. 
 

3. See the table below for additional options: 
 

Option Description 

(Templates) You can copy saved RSS Settings files (.rsf) to: 
C: \ Program Files (x86) \ C- nario \ Messenger 3 \ Cus-  

tomItems \ RSS Master \ Templates"  

They will then appear in the templates drop-down menu. 

(Load Settings) Load previously saved settings. 

(Save Settings) Save setting for re-use. 

(Load Defaults) Load previously saved defaults. 

(Save Defaults) Save RSS settings as default. 

 
 
 
 
 
 
 
 
  
 
 
  

 Textures 

To add a text item 

1. In the Layout or Library tab, click (Add Item), then click Text to open the Flexi Text 2 Master dialog box. 
 

2. In the main window, type the text you want to appear. 

3. On the toolbar, select the font, size, color, and 

positioning of the text. 

4. Format the text according to the following options: 

 

The size of the text is a percentage relative to the window size. 
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In the Name box, type a name for the text item. 

In the Editor Size section, type or select the size of the editor to fit the actual window it will be placed on. 

In the Continuous Scroll / Crawl Mode section, set the options according to the following table: 

 

Option Description 

Render Type 

Text As Image Renders text as single, full-sized image (default option). 

Direct Write For canvases driven by multiple player PCs. 

Text Properties 

Single Line Forces text onto one line. Clear the check box to allow line breaks in 

text that exceeds width of the window. Select this mode for scrolling 

/ crawling text only. 

Auto Font Resize Fits the text to the window. Select this mode for static text only. 

Text Opacity Increases or decreases the transparency of the text. 

Background Color Provides a range of color options that sit behind the text. 

Background Opacity Increases or decreases the transparency of the background color. 

Antialias Quality Prevents step-like effects on round shaped letters: 1=no antialias; 

5=best quality 

Shadow 

Style Select between a hard or soft shadow style. 

Vertical / Horizontal Shift Moves the shadow horizontally or vertically, relative to the text. 

Blur Ratio Blurs or sharpens the shadow edges, can only be used when Soft 

Shadow style is selected. 

Opacity Increases or decreases the transparency of the shadow. 

Texture 

Use Texture Browse and select a texture for the text. This will replace a color. 

Style Flips the texture on its axis. 

Outline 

Use outline Set the color, width and opacity of the outline around the text. 

5. 

6. 

7. 
 

Option Description 

Direction Allows you to choose the direction the 
text will move across the window. 

Duration Allows you to determine the length of 
time (in seconds) it takes for the text to 
move across the window. 
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Option Description 

Gap Allows you to determine the gap (in percentage relative to window 

size) between text appearances. A 100% gap means that the next 

item will appear only when the last one has finished playing. 

Auto Resize This option is grayed out if any motion is selected. This advanced 

feature is usable only in Static mode Direction. Using this selection, 

you can auto resize the rendering Vertically or Horizontally. 

Alternatively, you can choose not to auto resize the item by selecting 

None, (which will show only the rendered text that fits in the 

designated window). 

8. Select the Use Device check box to enable the text item to expose a 'Device' and a 'Pin' that will allow external 

control over the inputted text. See . 

 
 .flv 

 .mkv 

 .ts 

 .tss 

Click the Preview tab to preview the text. 

Click OK. 

5.1.7  Video 

You can add high end quality videos, in the highest resolutions, with set time code to playback on screen. Messenger 

supports the following formats: 

 

 

 

 

 

 

 

 

 

 

.mpg 

.mp3 

.m2v 

.mp2 

.wav 

.avi 

.wmv 

.wma 

.mov 

.mp4 

 

Adding a video item is done through the Fleximedia dialog box. This allows you to play back a multiplexed 

audio-video where you can choose whether to include the audio with the video playback. 




































































































































































































































































































































